
Digital Performer 10.13 Read Me

Thank you for installing Digital Performer 10.13.

*****

Complete DP10 documentation
You can find complete DP10 documentation (PDF files) in Digital 
Performer's Help menu. Table of Contents entries, index entries, and 
cross references are live links that will jump to their destinations. In some 
cases, you may need to click directly on the page number (rather than 
the heading).

Changes and new features
For a comprehensive list of new features, please refer to New Features 
in Digital Performer 10, available in Digital Performer's Help menu, which 
provides the page number in the manual for each new feature.

Enhancements introduced in version 10.13

Enhancements and optimizations
• DP is now Notarized for Catalina.
• Moved the Play column in the chunks list to the left of the name.
• Updated AU, VST2 and VST3 wrappers to return parameter 

names from effect instances.  Updated the "insert type" dialog in 
DP to get the correct parameter names. This allows VEP to return 
custom parameter names from each VEP instance (with the 
updated version of the MAS VEP plug-in from VSL).

• The QuickScribe cursor no longer disappears when in note insert 
mode. This fixes issues with tool palette selection when the tool 
palette is open over the score, and improves usability of mouse 
navigation while using insert mode in denser scores.

• QuickScribe cursor movement and navigation has been sped up, 
especially in denser projects.

• Addressed a performance bottleneck in projects with a large 
number of multi-port VIs and associated MIDI tracks (for example 
30 VEP plug-ins, each with 48 MIDI ports, and each VEP plug-in 
with 16 associated MIDI tracks).

• Beat detection has been improved.
• Marker names can now be 255 characters long (instead of only 

128).
• The Tracks Overview window will now always break phrases when 

a new meter event is encountered instead of only doing that in 
dynamic phrase breaks.

• Added optimizations to speed up scrubbing with audible mode 
enabled for sequences with large track counts.

• Changed the visibility of the inserts in the Sequence Editor from a 



per-sequence preference to a global preference.
• Added a preference to control the expanded state of the Clip 

Editor parameters pane.
• The Tracks Overview is now much more responsive when 

displaying lots of clips.
• DP is now more likely to be able to successfully open previously 

unreadable files.
• Double-clicking on names of instrument tracks in the Sequence 

Editor now opens the first editable insert.
• Improved the ability to open Format-1 Standard MIDI Files that are 

not compliant with the format specification (because of tempo, 
time signature, or SMPTE offset meta events in tracks other than 
the first one).

• Adding and removing tracks is now much faster in projects with 
large track counts and large numbers of virtual instruments with 
published MIDI ports.

• As requested by many users, we have restored the bite layering 
behavior from DP 9.52 that results from deleting samples from the 
middle of a soundbite (with the resulting earlier bite layered behind 
the later bite).

• Digital Performer no longer automatically sets sync ports when 
importing audio files.

• On Windows, DP now employs the system screen resolution 
setting to calibrate UI scaling so that 100% is reasonable and 
usable.

• Added shortcuts for scaling from 100% to 200% in 25% 
increments to the scaling window menu. Also added an advanced 
command for incrementing/decrementing UI scale by 5%.

• Changed the default Audition Volume for DP from -6 to -12 dB.
• Edits to data in MIDI tracks during playback will no longer mute 

currently sounding notes if the edits are reasonably far away from 
the playhead.

• Added a new MIDI Editing preference that allows pitch rulers to 
show note names on all pitch keys in the ruler. When enabled, if 
you zoom out the ruler (and the keys get narrow), note names will 
only appear on white keys. When this pref is disabled, note names 
only appear on octaves (C3, C4, etc)

• Improved the display of accidentals in MIDI note names, using the 
proper music notation symbols for sharp/flat. Improve readability, 
especially at higher vertical zoom levels, regardless of the 
horizontal zoom.

• When importing clippings, DP will attempt to resolve missing VI 
MIDI destinations referenced by imported Device Groups.

• DP no longer writes average tempos into soundfile metadata. This 
addresses issues where third party editing software may use the 
average tempo approximation to time-stretch sound files 
incorrectly.



• The splash screen now scales appropriately on Windows based 
on the system’s screen resolution setting.

Fixes
• Fixed a bug where the Marquee Selection radio group in the MIDI 

Editing preference panel might show the wrong value.
• Eliminated an unnecessary "Remap MIDI devices" dialog alert, 

most commonly seen on Windows under certain circumstances.
• Fixed a bug which caused the Clip Parameters Pane not to 

correctly reflect the focus state of the Clip Editor when the Clip 
Editor is first opened.

• Fixed a bug in which selected sections of the waveform in the 
Waveform Editor would not draw correctly when zooming 
vertically.

• Fixed a bug where deleting a track being shown in a MIDI Graphic 
Editor could crash.

• Fixed a long-standing issue with the vertical positioning of track 
icons in the Track Inspector.

• Fixed a vertical alignment issue in the CursorInfoPanel.
• Fixed the note name display in info strips/across the UI. The 

Graphic Editors now use musical symbols and all others places 
will continue to use text-based (b/#) symbols.

• Eliminated Windows display glitches related to certain Windows 
display resolution settings.

• Reduced the tooltip delay on Windows to match the Mac setting.
• Changed " kHz" to just "k" in the Sample Rate indicator to allow 

more rates to be displayed without resorting to a condensed font.
• Fixed a visual glitch in the Event List where the edit text boxes of 

certain MIDI fields would overlap with the icon.
• Fixed a bug in the Split Notes dialog where opening it with a 

keyboard shortcut and hitting Enter on the keyboard could often 
default to creating a new track, regardless of the current setting.

• Fixed inverted logic in "Subtract Offset From Duration" UI in Step 
Record.

• Fixed a crash bug when setting the master track using the track 
selector, in the Drum Editor.

• Fixed a display glitch in the Scale Time and Split Notes dialogs.
• DP now won't crash when opening movies with audio tracks 

containing non-standard channel counts.
• Fixed "Info Bar Preferences" crash from Channel Strip mini-menu 

when no channel strip is selected (such as when a new document 
is created, before tracks are added).

• Fixed a crash that could occur when using beat clicks and shutting 
off MAS.

• Fixed a display issue with Performer’s Mixing Board narrow view.
• Fixed a vertical height alignment issue in the Selection Info strip.
• Fixed a bug where chunks with V-rack-referencing MIDI tracks 



would have their MIDI destinations disconnected when loaded into 
their own source project.

• Fixed a rare crash that could occur when issuing the "Create 
Tracks" command.

• Fixed a problem that was causing automation values to not be 
correctly updated when setting the transport location.

• Fixed a problem with the same data type (like bypass) being 
automated by more than one plug-in of the same type in the same 
track. (Only one value would be chased.)

• Fixed a bug that was causing the filter in the automation setup 
dialog to not operate correctly.

• Changed the behavior when ending automation record passes to 
only insert return ramps — when in touch, latch or overwrite mode 
— if there are existing points forward of the pass-end point.

• Improved horizontal scrolling on Windows.
• Fixed pinch-to-zoom detection on Windows trackpads.
• Improved access to popup and dropdown menus to help prevent 

mis-clicks that result in unintentional actions.
• Fixed a bug with very long marker names that caused file 

corruption.
• Fixed a longstanding bug where Tap Tempo was not properly 

averaging user input.
• Prevent a crash in the Clips Window when pressing an arrow key 

in a new project without having previously selected a clip.
• Reduced CPU usage when the Clips Window is open and idle.
• Fixed an issue (having to do with pitch data) that would prevent 

some DP projects created in earlier versions from opening. These 
projects can now be opened in version 10.13.

• Fixed a Mac-specific issue with printing when the UI is scaled up.
• Improved the appearance of Retina cursors on Mac.
• Dragging an item from the Content Browser now selects the item 

before performing the drag.
• Fixed an issue causing the Scissor tool to not function on selected 

notes in the Clip Editor.
• Fixed an issue that made it impossible to drag and drop multiple 

midi files into the Sequence Editor at once.
• Fixed a crash that could happen if you select File > New while a 

project is open, then cancel the resulting Save As dialog.
• Fixed a crash that could happen when creating a new project from 

a template project.
• Fixed a crash that would happen when opening a standard file 

dialog such as Save As when the directory it shows contains an 
alias file pointing to a file that no longer exists.

• Fixed a freeze/crash on Windows which can occur when certain 
types of MIDI devices are disconnected while DP is running.

• When dropping sequence data (clippings, midi files, etc.) with non-
conductor tracks and only trivial conductor data at time zero, don't 



put up the Merge Conductor Data dialog and don't merge the 
conductor data.

• When dropping sequence data (clippings, midi files, etc.) 
containing only a conductor track, don't ask the user. Just go 
ahead and merge it.

• When making a new project, all the tracks and document 
properties properly inherit the defaults.

• Enabled "Edit <CC#>" commands in the clip editor to quickly 
switch between edit layers.

• If you move a clip to a new track or scene in the middle of the 
record pass, recording now stops.

• Changed the MIDI ruler to always display with a keyboard-style 
layout.

• Fixed a bug in which Change Meter might not insert a new meter 
change event at the requested start measure.

• Fixed a bug that was preventing 32-bit float files created via 
Bounce from being imported.

• Fixed a crash that could occur when opening old projects with 
loops.

• Fixed a crash bug that could occur running an export bounce-to-
disk operation (for example, using LAME or CoreAudio) with a 
song chunk play enabled.

• Fixed a Mac bug where moving the Movie window between 
displays would cause the view to be the wrong size for the window 
or to not show up at all.

• Fixed a bug where undoing a MIDI edit on a locked track could 
delete more data than was created by the action being un-done.

• Fixed an issue where MIDI timing might not be accurate during 
real-time bounce.

• Fixed an issue where the first few MIDI events in a track might be 
doubled during real-time bounce.

• Fixed an issue with the Scale Tempo window.
• Fixed some graphical artifacts when drawing selections highlights 

and track folders in the Tracks Overview.
• Fixed a bug where the auto-scroll hotspot would start outside the 

window bounds when dragging the mouse in the Clips window if 
the embedded track selector were open.

• Fixed an issue with Plogue plug-ins.
• Fixed an issue with displaying windows on mulitple screens.
• Fixed some display issues for extremely long clips in the Tracks 

Overview.
• Fixed some bugs that could cause a crash in the Tracks Overview 

if a single MIDI phrase contained too many notes.
• Fixed a bug in the Sequence Editor where clicking in the middle of 

a clip would edge edit it rather than select it if the clip's duration 
was very long.

• Fixed the default preference for Rounded Rect Notes.



• Fixed a bug where custom consoles and MIDI Device Groups 
targeting MIDI destinations published by plug-in instances would 
not be able to find their targets when imported via "load."

• Fixed a crash that could occur when bouncing to disk using 
individual tracks as sources. This crash seemed to mostly occur 
under Windows.

• Fixed a bug where queuing a clip scene in Track Record Mode 
while any tracks are record-enabled would queue clips for 
recording on the record-enabled tracks.

• Fixed a bug that could cause inconsistent MIDI CC drawing if a 
track had multiple CC events at the exact same tick but with 
different values.

• Fixed a crash when recalling Window Sets that included Region 
menu operations. The Region operation window will no longer be 
present in the Window set until you resave the Window Set with 
the desired Region op window opened.

• Fixed a crash that could occur when shifting track data to a time 
before the first measure of the sequence.

• Fixed a bug where clicking with the zoom tool (without dragging) 
would not zoom in the Graphic Editor windows.

• Fixed a bug that could have positioned the clip editor at the top of 
the consolidated window instead of at the bottom.

• Fixed a crash when dragging data from the Clip Editor to the Clips 
Window when the drop destination is the clip cell holding the clip 
currently opened in the Clip Editor.

• Fixed an issue with pencilling Meter/Key information in MIDI Editor 
Conductor Track.

• Fixed a crash that could occur when undoing the recording of a 
new soundbite clip in the Clips Window.

• Fixed a bug where dragging a sound file into the clip editor 
timeline would insert the sound file into the clip's owning track, 
instead of into the clip itself.

• Fixed a visual glitch in the Region Transpose dialog (and others).
• Fixed a crash that could occur when deleting soundbites from the 

Soundbites Window that were used by any clips in tracks.
• Fixed a bug where undoing the deletion of a soundbite in the 

Soundbites Window would not always restore them to clips that 
used them.

• Fixed a bug that could cause a crash when simultaneously 
starting recording into a clip in the clips window and starting 
playback (from a stop, with Play on Clip Queue enabled).

• Fixed a bug where non-default QuickScribe track options would be 
added to tracks that shouldn't have them when opening a project 
file. This would cause the default options to be ignored.

• Fixed a bug where penciling a SysEx event into the clip editor 
would actually insert the event into the clip's owning track.

• Fixed a bug where queuing a "track playback" clip would queue 



silence.
• Fixed a bug where the clip parameters pane would always show a 

black square if the clip color was unset, regardless of the track 
color.

• Fixed a bug on Windows where the wiper playhead would appear 
pixelated relative to the rest of the UI when scaled up.

• Forced Windows to use 2x cursor assets on screens with a 
system UI scale setting >= 150%, and adds Retina graphics 
assets for remaining non-retina cursors.  

• Fixed a QuickScribe bug where the Tool Palette was redundantly 
scaled on initialization, creating excessive empty space around it 
with UI scaling > 100%.

• Fixed a crash that could occur when drawing waveforms.
• Fixed a bug that would sometimes cause audible mode MIDI 

notes to sound a half-step up.
• Fixed a long-standing bug where clicking on a seemingly empty 

area of a track strip in the Sequence Editor or Clip Editor would 
switch the strip to the layer holding the event at the click point, 
even if the event had been invisible due to "Show Only The Active 
Edit Type" being enabled.

• Fixed numerous long-standing issues with modal windows when 
running under Windows.

• Fixed an issue that could cause clip events' loop indicators not to 
be displayed when first recorded into a track.

• Fixed a bug where the QuickScribe window that would sometimes 
make it impossible to view notation near the bottom of the page 
during playback. 

• Fixed a bug where changing the zoom in the QuickScribe window 
would cause the wiper to disappear.

• Fixed a bug that was making "Edit system margins" unusable in 
QuickScribe.

• Fixed a bug where "Snip" might not apply continuous data and 
tempo events chased at the edit boundaries when smart selection 
is enabled.

• Fixed a Windows bug where the cancel button on the Bounce To 
Disk progress window would didn't work.

• Fixed a Windows bug that caused the Bounce To Disk progress 
window to flash unusably when displaying in front of floating 
plugins.

• Fixed a Mac specific bug that could cause a slowdown when 
clicking on the main menu bar.

• Fixed a bug that could sometimes cause certain MIDI controller 
events (especially sustain and other switch types) to be dropped 
when playing back through the Quantize insert effect.

• Fixed a bug where “Stretch" would not be enabled on a track 
duplicated from another track with “Stretch" enabled.

• Fixed a bug causing the pitch ruler not to update correctly while 



dragging a MIDI note in the CE or the SE.
• Fixed a long-standing Sequence Editor bug where scrolling slowly 

with tracks displaying a pitch ruler in "piano-style" display might 
not correctly redraw the top-most and bottom-most keys on the 
pitch ruler, resulting in strange gaps appearing next to the black 
keys.

• Fixed a Mac-specific issue that could cause weird window sizes 
when creating projects from the default and factory template 
projects on a system with multiple displays.

• Fixed a bug where irrelevant options for pitch and time shifting 
audio would show up as disabled context menu items on MIDI 
tracks in the Clip layer.

• Fixed a crash that could occur when closing the Content Browser 
while a sound file is auditioning.

• Fixed a bug where copying MIDI data and pasting it into an empty 
cell in the Clips Window would mistakenly paste default controller 
events that don't exist in the copied data.

• Fixed a bug where using the option to "Scale all tempos to fit new 
end time" in the Scale Tempos region op would produce incorrect 
results.

• Fixed a bug where the "Convert Audio File" would not remember 
the last used interleaving option.

• Fixed a bug where MIDI Device Groups assigned to VIs in a 
template would not find those VIs after creating a new project from 
that template.

• Fixed a bug where device groups created from duplicating other 
device groups in the same project (for instance, when duplicating 
a sequence) would be missing after saving and re-opening.

• Fixed a bug where the mute tool would not mute all selected notes 
in the Clip Editor.

• Fixed the labeling and description of the mute tool in the Tool 
Palette Options preference panel.

• Fixed a bug where a sustain pedal event in a clip might be 
dropped if the event occurred exactly at the start or loop start time.

• Fixed a list pane bug which resulted in being unable to correctly 
drag columns and reorder them when the Soundbites window is 
horizontally scrolled a significant distance to the right.

• Fixed a Windows-specific behavior difference where certain types 
of clicks might fail to activate the window if another process is 
currently the foreground.

• Fixed a Windows issue where plug-in UIs could initialize on top of 
DP's controls, instead of below them.

• Fixed Humanize when used as a region op on tempo events.
• Fixed a bug where exporting soundbites using a plug-in format 

could crash.
• Fixed a bug where bounce to disk on a non-current sequence 

containing a forced-realtime-VI could hang.



• Disabled UI scaling in the Welcome Window when running on 
macOS 10.11 or 10.12, to sidestep an issue where the Welcome 
Window would scale incorrectly and exceed the window frame 
size.

Enhancements introduced in version 10.11

Version 10.11 introduces the following fixes: 

• Fixed bug were the wiper would stop moving when mouse was not 
moving.

• Fixed a bug where seeking backward one frame at a time would 
not reliably update the displayed video frame in the movie window.

• Fixed the CC MIDI event colors (and names) in the document 
templates.

• Fixed the default numbers and strings for CC data preference.
• Fixed a bug affecting macOS Catalina where open and save 

dialogs would not forward mouse clicks and other UI events to the 
custom accessory views embedded in the dialog (for selecting file 
formats, etc).

• Fixed an invalid memory access in the save dialog (Mac only).
• Fixed a crash that could occur when opening older documents 

that had loop lanes showing in the Sequence Editor.
• Fixed a bug where garbage data could be saved into a file if the 

project had loop events in them from earlier versions of DP. These 
projects could then crash DP when reopened later, so we added a 
workaround to open these projects successfully.

• Fixed a potential crash when closing windows.
• Fixed a bug where "Mute Toggle Selection" would not work on 

soundbites.
• Fixed a bug where the option to "interpolate automation events at 

edit boundaries" in the Event Chasing window would be invisible 
in some themes.

• Improved the edit boundary automation chasing feature's ability to 
avoid inserting unnecessary "anchor" events.

• Fixed a bug in the edit-boundary automation chasing in which only 
one effect parameter's automation would be preserved around the 
edit boundaries if the edit involved automation for the the same 
parameter on multiple instances of that effect.

• Fixed a crash when using Groove Quantize on an audio track 
selection.

• Fixed a bug where too many undo entries could be created when 
using Groove Quantize.

• Potential fix for intermittently unresponsive video playback.
• Fixed a bug where slowly dragging a marquee selection in the clip 

editor piano roll with smart selections enabled would sometimes 
not redraw notes when their selected-ness changed.



• Improved responsiveness of dragging a marquee selection in 
piano roll views with lots of notes while smart selections are 
enabled.

• Fixed a crash that could occur when dragging a chunk to the Song 
window.

• Fixed the document templates to have a default movie start time 
of 1:00:00:00.

New features introduced in version 10.1

Clips in tracks
• You can now put clips in tracks so they play at the desired time 

without having to queue them manually in the Clips window.
• Edit clips in tracks with all of the same methods you're 

accustomed to when editing soundbites: split, trim, drag and drop, 
edge edit, copy/paste and more.

• Drag the trailing edge of a clip right to reveal additional repeats of 
the clip's looped section.

• Drag the leading edge of a clip left to either a) make space for 
grace notes, fills and other pre-loop content (if the clip start point 
is set prior to the loop start), or b) reveal additional loop iterations, 
similar to dragging the right edge (if the clip start is within the loop 
range).

• Double-click a clip to open it in the clip editor.  
• Use the new Pack command to move selected data out of a track 

and into a new clip at the same time within the track.  
• Use Unpack to delete a clip and place its contents at the same 

time within the track.

Capture played clips to tracks
• You can record the clips you trigger in the Clips window into tracks 

for later playback, recreating your performance.

Record MIDI into a track clip
• When recording into a MIDI track, you now have the option to 

record the MIDI data into a new clip within the track.  
• A new preference (MIDI Options > Record MIDI in Tracks as 

Clips) allows you to disable this and go back to traditional MIDI 
recording where the events go directly into the track.

Record in the clips window
• You can now record directly into an empty slot in the Clips 

window.
• In Clip Record mode (option/alt-click the main record button), you 

can record directly into an existing clip or an empty slot in the 
Clips Window.

• If you are capturing clip playback to tracks, any new clips you 



record into the Clips window can additionally be captured into 
tracks as you record them.

Memory Cycle and Auto Record strips in SE and GE's
• Memory Cycle points are no longer small icons in the time ruler.  

Instead, they appear in a new strip and colored bar.
• Same for Auto Record Punch-in/out. It's now a strip with a colored 

bar.

Enhanced zooming gestures
• Zoom with the two-finger pinch gesture on your track pad.
• Pinch to zoom in the pitch ruler.
• Hold option (alt on Windows) to zoom with the mouse wheel. 

Mouse Wheel now makes the Song Pane scroll.
• To zoom pitches in the grid, use control + alt + mouse wheel.

Enhanced piano roll marquee (arrow tool)
• Midi piano roll marquee now selects notes when overlapping any 

part of the note, not just the head.

Automatically zoom MIDI notes
• You can now set individual MIDI tracks to zoom pitch 

automatically in the sequence editor so all notes are visible.

Larger MIDI data icons
• MIDI note velocity, controller, pitch bend and other data types are 

now larger and easier to click on in the MIDI editor and the 
Sequence editor.

• Note velocities now appear with a trailing line corresponding to the 
note duration.

Velocity tool
• Edit note velocities directly in the piano roll with the new velocity 

tool.  The velocity tool also provides an easier way to edit 
velocities in the continuous data editor, modifying any number of 
notes at once with a single gesture.

Hand tool
• Scroll precisely and intuitively with the new Hand tool.

Retrospective MIDI Record
• Digital Performer is always capturing MIDI input, even when the 

main transport is not recording.
• This happens during normal playback and even when the main 

transport is completely stopped.
• This is extremely useful if you forgot to press the master Record 

button before playing...or if you prefer to improvise freely, on the 



fly.
• To insert captured material into a track, record-enable the track or 

open the MIDI Editor or Drum Editor, then choose Region menu > 
Retrospective MIDI Record.

• If the material was captured while the transport was rolling, it is 
placed in the track at the time it was played.

• If the material was captured while the transport was stopped, 
simply place the playback wiper at the desired location in the 
track, and it will be inserted there.

• To insert the material in the Clips window, right-click on any cell 
and choose Retrospective Record from the menu.

• If the cell was empty, the captured material is inserted into a new 
clip.

• If the cell already had a clip in it, the new material is merged into 
the existing clip.

Bounce to Disk enhancements
• You can now choose to bounce in real time or faster than real time 

(with the Offline bounce option).
• The new "Bounce Includes Audio Patch Thru" option allows you to 

include monitored inputs (from VI's or live external sources, for 
example) while bouncing, either in real-time or offline.

• You can now bounce multiple files (stems) in a single operation.
• You can now choose to bounce tracks, outputs or both during a 

single bounce operation.
• When bouncing tracks, you have the option of matching the 

channel format of the track or the track's output (for example, a 
mono track assigned to a stereo output).

Interpolate chased automation events when editing
• Added a preference in the Event Chasing window to interpolate 

automation events at edit boundaries, thereby preserving the 
surrounding automation curves.  (This preference is enabled by 
default.)

• When enabled, copying track data selections will interpolate ramp-
style automation events at the selection boundaries and include 
them when pasting, merging, splicing, or shifting the clipboard 
data. 

• Additionally, DP will interpolate automation events at the paste/
merge/splice/shift destination boundaries.  

• This new preference improves on and replaces a similar feature 
that was previously enabled and disabled by turning Smart 
Selections on and off.

Performance Optimizations
• Improved drawing speed when using marquee selection in the 

MIDI editor. 



• Improved speed when cutting / deleting selected events.
• Improved speed of sequence editor updates when the selection 

changes.
• Improved speed and responsiveness when dragging soundbites in 

the sequence editor.
• Improved scrolling efficiency in the Tracks Overview.
• Make pitch scrolling much faster in the MIDI Editor, Sequence 

Editor, and Clip Editor.
• Don't redraw the entire track grid when "deselect all" is called and 

only a small number of pixels need to change.
• Improved the speed of Clips window selection changes during 

marquee mouse tracking.
• Made horizontal scrolling more usable in large projects by 

avoiding computations for strips that aren't even onscreen.
• Don't redraw the cursor info panel's layout each time the mouse 

moves - it's too slow to do it that frequently. Only update the 
information it's displaying. This should fix the sluggish response 
when dragging the wiper and when scrolling vertically in the 
sequence editor, as well as an issue where the counter would stop 
updating while moving the mouse cursor in a window with lots of 
data.

• Improved responsiveness of clicking on menus, especially on 4K 
displays.

• Small optimization in the track selector command handler.
• Fixed a few places where the sequence editor was being redrawn 

unnecessarily.
• Added a number of miscellaneous UI-efficiency improvements.
• Speed up for SE views densely populated with soundbites.
• Fixed a bug where DP would become unresponsive when the 

sequence editor had a huge number of automation points to draw. 
• Made automation point drawing much faster.
• Fixed a bug where the graphic editors would redraw twice when 

changing the time zoom via a command (would redraw once at 
the old level and again at the new level).

• Improved the speed of changing the MIDI Editor's master track. 
• Improved continuous data editing efficiency in the MIDI Editor by 

not redrawing the note grid for selection changes that don't involve 
notes. 

• Added some optimizations for continuous data mouse tracking 
operations.

• Fixed a bug where the entire Tracks Overview would redraw when 
scrolling if the scrolled viewport edges mapped to fractional device 
pixels. This can happen when the UI scale factor is not an integer; 
a padding region is redrawn around the viewport in this case.

• Dramatically improved drawing speed when dragging the scroll 
bar to the right while lots of velocity icons are showing.

• Improved the speed of opening selected tracks in the MIDI Editor.



• Improved the speed of changing track visibility in the Clips 
Window track selector when there are lots of tracks in the 
sequence.

Additional enhancements
• All MOTU-supplied plugins and data bundles are now contained 

within Digital Performer's application bundle, so new versions of 
DP won't overwrite earlier versions' plugins.  Digital Performer still 
looks for and loads third-party plugins from the same locations as 
before.

• Update "saving old file in new format" warning dialog to include 
the minor version number instead of just "DP 10".

• When reading or writing key bindings, bindings involving the 
delete key are only forcibly considered non-custom if they have no 
modifiers.  Bindings to delete and any combination of modifiers 
are treated just like any other binding.  This means that customers' 
custom key bindings involving the delete key will no longer 
disappear when they get a new version of DP.

• Added new document templates and removed the old ones.
• Auto grid snapping is now a global preference, so if you don’t want 

to use it, you only have to disable it once, ever.
• Added a "Clippings" preference section to the preferences window 

with an option controlling whether bus bundles are remapped 
when importing track data clippings.

• Save the value of View > "Show Only The Active Edit Type" in a 
preference so it doesn't get lost every time you quit DP.

• Removed "Show Active Layer Only" from the sequence editor's 
mini-menu because it now lives in the View menu.

• Added a preference to draw rectangular MIDI notes for improved 
speed and better visual alignment of the start time.

• Change the default preference value of "Create new bus bundles 
when importing track data clippings" to false.

• Input quantize settings are now saved as a preference, so they 
persist after quitting and reopening DP. 

• Removed the 'Upgrading Command Bindings' preference panel 
section - the preference has had no effect since 2010.

• Added a preference to enable or disable note velocity duration 
bars in the MIDI editor continuous data grid.

• Added a new preference for audio audition volume. It's in the 
audio options pref section.

• Updated the track type-specific default color preferences so they 
aren't all set to the same color. Also change the default preference 
for "Assign new tracks..." to "to the same color / use different 
colors for different track types."

• Added a new preference in the Automation Setup window to "send 
default volume and pan to MIDI destinations when playback 
starts". When enabled, MIDI tracks that do not have volume / pan 



events in the track (and are not controlled by a VCA track with 
volume automation) will send their current channel strip volume 
and pan values to their MIDI destinations when starting playback. 
The preference defaults to "off," which should prevent an issue 
where VI tracks that had been mixed in the plugin GUI have their 
volume and pan paremeters reset to the Mixing Board state when 
starting playback.

• Allow users to change the scrolling speed in Preferences -> 
Scrolling and Zooming.

• Update the track type-specific default color preference so that they 
aren't all set to the same color. Also change the default preference 
for "Assign new tracks..." to "to the same color / use different 
colors for different track types."

• Removed the default MIDI command bindings.
• The Chunk List window now allows you to set a color for each 

chunk.
• Updated how Chunk colors are set by default.
• Reordered the Chunks window columns.
• Tweak the default document window cell focus ring color to be 

slightly more visible.
• Changed the color of muted midi notes to make it easier to see 

which are muted and which are not.
• The Tracks Overview and Sequence Editor windows will swap the 

background and data color of the clip event currently shown in the 
clip editor to make it easier to discern at a glance which clip is 
being edited.

• Continuous data now correctly follows the color set in View > 
Colors > Set Continuous Data Color.

• Muted notes are now translucent.
• Now you can change CC and Midi data colors in the Legend 

window.
• New Default colors for CC and MIDI Data.
• Made the non-active automation data types transparent in line 

mode, making it easier to see and edit the active data type.
• Allow changing track record enables while playing and recording 

without glitching.
• Modified the control panel buffer size popup menu to cause less of 

a disturbance in the audio system (plug-in samples should no 
longer reload).

• Replaced the cycle/auto-record indicators in the Sequence Editor, 
MIDI editor, Tracks window and loop/clip start indicators in the Clip 
Editor with lanes under the time ruler to more easily edit those 
parameters.

• When the transport record button is engaged, it will flash while no 
tracks are record-enabled and none are capturing clip playback in 
the clips window.

• The strip type popup menu at the bottom of the clip editor footer 



will automatically update itself after a new data type is recorded 
into a clip. This should make it easier to verify that a new type was 
recorded if "Show only active edit types" is enabled for the clip 
editor.

• Reduce time required to reset MAS when the user has specified a 
large number of buses.

• Added a way for bounce to disk to include audio patch-thru. The 
setting is in the bounce settings menu.

• Added a new kind of Snip "Snip And Adjust Note Duration".
• The I-Beam now allows multi track selection.
• Tweaked the auto grid to better support a wider variety of meters 

and meter changes.
• The Duplicate command now works with event ("object") 

selections in addition to time range selections.  This is good for 
quickly repeating soundbites and clips in the sequence editor.

• In the Sequence Editor, "Zoom To Selection" will now zoom so 
that the selected tracks fill the window.  The old behavior is 
available via a new command named "Zoom to Selected Time 
Range.”

• MIDI automation now snaps to high, low and zero position in its 
grid when you hold control while dragging.

• Added the ability to constrain to H or V scrolling by holding control.  
Also added a preference to invert this so it is locked and hold 
control to unlock scrolling (Preferences > Scrolling and Zooming > 
Scrolling With Trackpad).

• Revamped the drag auto-scroll logic to make it more controllable 
when dragging past the edge of the pane.  It now scrolls slowly 
when you're just a little bit past the edge, and smoothly begins to 
go faster as you move farther past the edge.  This change applies 
in the sequence editor, MIDI editor, clips window and tracks 
overview.

• Revamped list scrolling to make it more controllable
• Disabled the "Move controllers with notes" setting by default in the 

input quantize window.
• Using the "Zoom To Default Zoom" command in the clip editor will 

center the editor on the playable region of the clip, as if it were the 
first time opening the clip for editing.

• Updated additional parts of the program to use the new smoother 
and more controllable autoscrolling feature: scrub tool, velocity 
tool in continuous data editor, scissor tool, pencil tool, mute tool, 
drum reshape tool, drum rhythm tool, median strip, marker strip, 
loop strip, sndbite drag out, MIDI editor selection.

• Made autoscroll speed more controllable when dragging wipers.
• Changed the "move controllers with notes" feature of the quantize 

effect to only insert events that were synthesized on note 
boundaries if those events differ in value from the event of that 
type immediately preceding it. This should prevent an issue where 



one CC64 "pedal down" event becomes many CC64 "pedal down" 
events due to note boundary chasing.

• Made it so that when the clip editor opens an empty MIDI clip for 
the first time, it centers the pitch zoom around C3 in the same way 
as auto zoom does in the Sequence Editor.

• The clip editor now displays the snap info bar at the top, so you 
don't have to go all the way to the snap information window to 
change the grid settings.

• Made the clip editor grid settings unique per sequence rather than 
per clip. This way they are retained when switching the clip editor 
target (within the same sequence).

• Enabled vertical zoom for MIDI tracks in the clip editor.
• Added cursor info and event info bars to the clip editor.
• Made the clip editor parameters pane more compact.
• Add a little space between notes in a clip so that they don't look 

like a single long note.
• Changed how the Overdrive knob is scaled in BassLine (to 

counter how it got "hot" too quickly).
• Added editable parameter readouts in BassLine below each knob.
• Changed knob control increments (and fine increments when 

holding the Command key) for BassLine, Modulo and Model12's 
pitch controlling parameters so that exact semitones / cent values 
can be selected with ease.

Fixes
• Worked around a problem that occurs when users install iOS 13 

system update on macOS 10.11 and 10.12, which was preventing 
DP from loading AU plug-ins.

• If Key Repeat is disabled in the macOS System Preferences 
Keyboard panel, MidiKeysGlog now disables simulation of 
autokeys when mousing on auto-key configured buttons.

• Fixed a bug in which clicking on the counter wouldn't work 
properly when Key Repeat is disabled.

• Fixed a crash when trying to scroll a list pane that had no scroll 
bar.

• Fixed a crash that could occur when using the mouse wheel to 
scroll while the cursor is positioned over a scroll bar pane.

• Fixed crash bugs that would occur when opening non-contained 
instances of the SE, GE and DE, opening the track selector, and 
attempting to scroll.

• Fixed a bug where clicking inside a value box wouldn't always let 
you edit the value.

• Fixed an issue where the scale time region op was just deleting 
clip events.

• Fixed an issue where MIDI notes would be removed during Scale 
Time regions ops when also affecting audio tracks, clip events will 
also now scale.



• Fixed a bug where "Move automation with quantized beats" 
wouldn't work.

• Fixed an issue where midi clips would not scale properly during 
Scale Time region ops, clip events will also now scale their loop 
and start time as well.

• Fixed a bug where the "Send notes to one new track" option of the 
Split Notes region op would not make a new track with the notes.

• Fixed a vertical scrolling bug that could cause parts of the scrolled 
area to not redraw.

• Fixed an issue that could cause both ‘tap to click’ and extremely 
short mouse clicks not to select items in lists such as the 
Preferences window and the Edit Track Color Schemes dialog.

• Fixed an issue where the start time editor would think the clip 
event duration was actually its original start time.

• Fixed a bug that would occasionally cause display glitches when 
scrolling while UI scaling is enabled.

• Fixed a bug where "Pack into Clips with Options" would crash 
when confirming or canceling the dialog using the keyboard.

• Fixed a crash when quitting DP after the color picker dialog had 
been used (macOS only).

• Fixed a bug where parameter changes in the Groove Quantize 
region op window would not apply to the track when "instant 
preview" was on.

• Fixed a bug where empty undo entries would be created each 
time a slider or other parameter was changed while using "instant 
preview" in the Groove Quantize region op window.

• Fixed a bug where a 1 pixel-wide rectangle of boundary strip fill 
color could be left behind on the left edge of the time ruler after 
clicking on or dragging the strip.

• Fixed a bug where chased notes in unselected clips would play 
back during "Audition Selection."

• Fixed the missing curve button labels in the Change Tempo 
dialog.

• Fixed a crash when hitting the escape key after opening the 
preferences window.

• Fixed a rare graphics bug that could occur when dragging 
windows on some external displays where the pixels inside the old 
and new window positions (including the title bar) would not 
redraw for many frames, or until the mouse was released.

• Fixed a bug in the Welcome Window where scrolling on Mac 
would cause a visual bounce effect.

• Fixed a Windows-specific bug where the Welcome Window would 
not respect system-wide DPI scaling, causing the Welcome 
screen to be extremely small on high-DPI monitors.

• Fixed a Windows bug where hairline artifacts could be left in the 
time ruler when drag-autoscrolling at UI scale factors greater than 
100%.



• Fixed a Run Command bug that would treat all search text as 
logographic when the app is running in Japanese mode.

• Fixed a bug where the preferences window scroll bar would be 
missing until you clicked on a different section.

• Fixed a bug where the fixed grid spacing setting for a new track 
may not be copied when duplicating tracks or using the "add 
similar tracks" command.

• Fixed a hang that could happen when closing the transpose 
region op window.

• Fixed a mac crash when dragging track data between different 
windows.

• Fixed an issue drawing the caret in Project Notes when scaled up 
on Windows.

• Fixed RegionTransposePane bugs.
• Fixed Piano Ruler scroll bug.
• Fixed a bug where control surface effect parameters might not be 

updated.
• Fixed a bug which made templates with apostrophes or quotations 

in the name to be unselectable.
• Fix an issue where the VST3 wrapper could crash when an effect 

was being deleted.
• Fixed code signing on Windows (so the app is no longer “from an 

unknown developer”).
• Fixed a bug where certain region operations would make more 

than one undo entry when operating on multiple tracks.
• Fixed a bug in the Quantize window where the  "Attacks," 

"Releases," and "Don't change note durations" checkboxes would 
not be clickable after enabling "notes" in the edit filter.

• Fixed a bug where dragging a clipping into the chunks window 
would fail to connect tracks to their output bundle assignments 
when those bundles exist in the project.

• Fix a crash undoing changes made in the Clips window.
• Fixed a crash when you delete a sequence while it's showing in 

the Clips window.
• Fixed a bug where "select all" would not work in the Clips 

Window's dedicated clip editor (when popped out of the CW).
• Fixed a bug where selecting an empty clip cell in the Clips 

Window and then resizing the window could cause the parameters 
pane in the clip editor to change to the wrong width and cut off 
some of the content.

• Fixed a bug where the Clips Window would not save the exact 
scroll offsets in effect when the window was closed.

• Fixed a potential crash when setting clip loops and start times 
(loop durations of zero are not allowed as they would crash DP). 

• Fixed a crash that could happen when using the quantize insert 
effect on a MIDI track that was playing back clips in the clips 
window.



• Fixed a bug where choosing "Create group" from the Clips 
Window's channel strip fader contextual menu would crash.

• Fixed a graphics bug when scrolling the clip editor piano roll and 
other list panes that have a drop shadow at the top and left, such 
as in the preferences window.

• Fixed a bug where the clip editor wouldn't let you scroll to the loop 
range in an empty clip if the loop range were later than the 
rightmost visible tick.

• Fixed a bug where select all would do nothing in the clip editor.
• Fixed a drawing glitch for the clip editor boundary strips.
• Fixed a bug where "Find beats" would have no effect on 

soundbites in the clip editor.
• Fixed a UI bug where the "clear color" and "learn/cancel" buttons 

in the clip editor were not wide enough to display all the text.
• Fixed a crash when using "Select All" when the clip editor window 

had focus but no clip was being displayed in it.
• Fixed a bug where incorrect time conversions were used in the 

clip editor when penciling data into a soundbite's pitch layer.
• Fixed a bug where the clip editor would draw marker lines from 

the main sequence.
• Fixed a bug where View -> Colors -> Set Continuous Data Color 

would not work in the clip editor.
• Fixed a bug where the strip type popup menu in the clip editor 

would sometimes show the wrong items.
• Fixed a bug where the clip editor might scroll to the wrong position 

after moving a clip in the sequence editor and auto scroll is 
enabled.

• Fixed a bug where selections in the clip editor could make other 
edit windows scroll to the beginning of the selected time range 
when the "windows scroll together" option is enabled for auto 
scroll, even though the clip's selection exists in a different time 
context.

• Fixed a bug where the clip editor might lose track of its clip after 
moving the clip event in the Tracks Overview and then undoing 
the move.

• Fixed a bug where the clip editor might lose track of its clip after 
moving the clip event in the Tracks Overview and then undoing 
the move.

• Fixed a bug where the clip editor would fail to clear itself 
completely after deleting its clip in the Clips Window.

• Fixed a bug where the Consolidated Window's clip editor would 
have a partial title tab showing after creating a new document 
from a template that has the clip editor open by default.

• Fixed an assortment of time conversion routines that were 
incorrect for the clip editor.

• Fixed a bug where the mute tool would not work on notes in the 
clip editor.



• Fixed some graphical bugs in the Drum Editor when the dedicated 
track selector is showing.

• Fixed a long-standing bug where the drum editor's time scroll bar 
would not appear at first when opening the window, and would not 
update immediately when changing the view resolution.

• Fixed a graphics glitch that could happen in the drum editor when 
you added a row in the note info side of the editor the grid would 
not update with a new row.

• Fixed a drum editor issue where the visual feedback did not 
correctly show what was being selected.

• Fixed a problem where automation types from plug-ins with a 
large number of parameters could not be inserted in the event list.

• Fixed a bug where the event list would not update after a track 
data change if the list had previously been empty.

• Fixed a crash in the event list.
• Fixed a bug where clicking to the left of a marker in the Markers 

window wouldn't rewind to that marker.
• Fixed a bug where deleting the only note event from a track in the 

MIDI editor wouldn't trigger a redraw.
• Fixed a bug where the "square notes" version of the pitch ruler 

was vertically offset from were it should have been.
• Fixed Scissor Tool in the MIDI editor so, when you click and drag, 

it once again snips on each grid point you cross over.
• Fixed a bug where some notes wouldn't draw in the new visible 

range after scrolling horizontally.
• Hairline now follows cursor when dragging continuous data
• Fixed a bug where using the new velocity tool on velocity icons 

wouldn't always redraw the corresponding notes until after the 
mouse task finished.

• Fixed a crash when opening the conductor track in the MIDI 
Editor.

• Fixed a bug where the ruler bottom could draw unevenly when the 
UI is scaled up.

• Fixed a bug where the blue marquee highlight would not go away 
in the MIDI editor if no notes were selected when the mouse was 
released.

• Fixed a bug where note velocities of value 127 were not visible in 
the MIDI Editor.

• Fixed a bug where the MIDI editor wouldn't redraw notes that had 
just been recorded if overdub mode was disabled.

• Fixed a bug where the MIDI editor wouldn't redraw after undoing a 
record pass.

• Fixed a bug where the MIDI editor sometimes wouldn't redraw 
notes that had just been muted.

• Fixed a bug where the marquee highlight would remain visible in 
the continuous data area of the MIDI editor after releasing the 
mouse if no events had been selected.



• Fixed some bugs in the Graphic Editor caching routines.
• Fixed a display glitch with ruler tick marks in the boundary strips 

when scrolling the MIDI Editor with the trackpad.
• Fixed a bug where auto-scrolling would be bounded to a very slow 

speed during marquee and zoom dragging in the MIDI Editor if the 
window's right edge was flush with the display's right edge.

• Fixed a bug when drawing MIDI continuous data in "bars" mode, 
where the bar line top was offset from where it should have been 
with respect to the ruler. This was leaving color fills after a zero-
valued (or "centered pitch bend wheel" valued) continuous data 
event, where the should have been no fill.

• Fixed a bug that happened when scrolling while pencilling in a 
MIDI note. The head of the note would scroll with the pane instead 
of staying at its start time. 

• Fixed a bug in the Mixing Board when using "Clear MIDI 
Controller..." where the click detection wouldn't factor in scroll 
offsets, and so would try to clear the MIDI controller for the wrong 
channel strip or the wrong section of the channel strip if the view 
had been vertically or horizontally scrolled.

• Fixed a bug where you could not delete a plugin from an insert 
slot in the Mixing Board if the window target was a V-Rack.

• Fixed a crash that could occur when dragging the only track in a 
mixing board.

• Fixed a crash that could occur when deleting MIDI effects from the 
mixing board.

• Fixed a bug where clicking in the empty area of the Mixing Board 
window after choosing "Create group" from a contextual menu 
would crash.

• Fixed a bug where QuickScribe would stop autoscrolling if you 
held the mouse perfectly still while dragging.

• Fixed an issue where the commands to move the QuickScribe 
insertion cursor up and down would not function.

• Fixed a bug where SndBitePanes would be missing when resizing 
the window while the soundbite layer was not the active edit layer.

• Fixed an issue where the piano roll ruler would not draw correctly 
in the Sequence Editor.

• Fixed a bug where grid lines in the sequence editor would 
sometimes not redraw when scrolling horizontally.

• Fixed a crash when penciling bite volume data.
• Fixed a bug in the Sequence Editor where soundbite waveforms 

would appear to change slightly as the wiper passed by after 
punching out and UI scaling was greater than 100%.

• Fixed a crash when dragging the zoom tool across a closed track 
folder and inconsistent results when dragging it from bottom to 
top.

• Fixed a graphical glitch with marquee selecting across tracks in 
the sequence editor.



• Fixed a bug where the soundbite pitch edit lane might draw data 
outside the bounds of the Sequence Editor.

• Fixed a bug where a marquee-highlighted region of a track folder 
strip in the Sequence Editor would remain after releasing the 
mouse.

• Potential fix for soundbite names drawing where they shouldn't in 
the Sequence Editor. 

• Fixed a graphical glitch when scrolling the soundbite pitch layer 
vertically in the Sequence Editor.

• Fixed a bug where you could not use the pencil tool to edit a 
soundbite's pitch layer.

• Fixed a bug where "Select All" in the sequence editor would select 
up To Tick::kMax (the end of time as far as DP is concerned).

• A potential fix for an issue where clicking a clip event in the 
Sequence Editor would cause the clip to snap to the grid.

• Fixed a bug where automation lanes would not draw contained 
data when first opened.

• Fixed a bug where the Sequence Editor might not draw the 
beginnings of clip events if they were slowly scrolled into view.

• Fixed a drawing bug where soundbite names wouldn't be clipped 
properly when occluded by other soundbites in the foreground.

• Fixed a bug where the sequence editor's time ruler and marker/
auto punch/memory lanes wouldn't always redraw correctly when 
using "Zoom back" and "Zoom forward".

• Fixed a crash when hiding takes in the sequence editor.
• Fixed a piano roll vertical scrolling bug in the Sequence Editor and 

Clip Editor when the note velocities edit type is active but velocity 
is hidden in the view filter.

• Fixed a bug where the continuation of MIDI controller events 
before the left edge of the viewport would not always draw in "bar" 
mode. 

• Fixed an issue where a fade out could disappear from the end of a 
long bite if shorter bites were layered on in the middle of the bite.

• Fixed scrolling bug in seq editor in the effects list.
• Fixed selection to match what is GUI is showing.
• Fixed a display glitch bug when scrolling while scrubbing.
• Fixed a crash when showing lanes on a VCA track in the 

Sequence Editor.
• Fixed a bug where marquee selecting across several tracks in the 

Sequence Editor might not select anything for tracks with lanes 
showing.

• Fixed a bug where the Soundbites window would draw the last-
clicked soundbite as selected, but would not update its internal 
state to reflect the new selection. This was causing selection-
based menu items like "Delete Soundbite" to be unavailable. It 
also fixes a bug where the Sound File Information window would 
not update to the new selection in the Soundbites window.



• Fixed crash in the Track Overview when dragging Endpoint 
Indicators.

• Fixed a graphics bug when using the trackpad or mouse wheel to 
scroll horizontally in the tracks list in the TO.

• Fixed a bug where the Tracks Overview wouldn't redraw when 
new tracks were added.

• Fixed a latent crash bug when dragging in the Tracks Overview.
• Fixed a bug where you could not click on data in the bottom-most 

track in the Tracks Overview.
• Fixed a bug where the time ruler in the tracks overview would not 

draw the time range selection highlight being dragged across it.
• Fixed a bug where the Tracks Overview divider would not be 

restored properly when re-opening the window while UI was 
scaled up.

• Fixed a bug where the Tracks Overview would would not draw 
phrase boxes for aux and instrument track automation.

• Fixed a bug where option-dragging a clip event in the Tracks 
Overview would create 2 additional copies of the clip instead of 1.

• Fixed a bug where using the lasso tool with the shift key over 
phrases in the tracks overview would not select those phrases.

• Fixed a bug where the marker lines superimposed over the auto 
punch and memory cycle lanes wouldn't redraw in the Tracks 
Overview when the markers moved.

• Fixed a bug where scrolling the Tracks Overview with the mouse 
wheel or trackpad could leave artifacts on the screen at certain UI 
scale factors.

• Fixed a crash in the Waveform Editor when scroll zooming.
• Fixed an issue where drawing waveforms would fail at certain 

zoom levels.
• Fixed a crash that could occur when closing the waveform editor.
• Fixed a crash when scrolling the pitch layer of the waveform 

editor.
• Fixed a crash that could happen when trying zooming in an empty 

waveform editor.
• Fixed a crash that could occur when clicking on an existing beat 

with the pencil tool.
• Fixed a crash when dragging a clip to a track with mismatched 

types.
• Fixed the ability to "run last bounce again" which had apparently 

been broken for some time.
• Fixed a long standing bug where DP could crash if multiple fades 

were selected, and then dragged to be zero in duration (deleting 
the fades).

• Fixed a bug where the selection highlight wouldn't draw in the 
MIDI insert effect version of groove quantize.

• Fixed Repeat to both restore previous behavior and also allow it to 
be used successfully with object selections (e.g. soundbite 



events).
• Fixed a crash that could occur when opening projects with bad 

audio output assignments.
• Fixed a bug that prevented setting I/O properties on audio tracks.
• Fixed a problem where saving as old DP versions could cause a 

crash in the old version of DP when the project was opened and 
then closed

• Fixed a Windows bug where "Save as DP7-9" would actually save 
as DP10.01.

• Fixed a crash that could occur when closing a project that had 
tracks with MIDI insert effects.

• Fixed Load for Consoles.  Now all setting should be loaded.
• Fixed a crash that could occur redoing deletion of a console.
• Improved the reliability of pressing cancel without crashing when 

DP is loading a large project.
• Fixed a crash when saving some documents as older DP 

versions.
• Fixed a bug where tempo changes migh not read in correctly.
• Fixed a bug that made saving projects using pattern clicks fail.
• Fixed an issue where running bounce to disk with a saved format 

involving an export plug-in could incorrectly yield a mono file.
• Fixed a bug where some track clippings made by older versions of 

DP could not be imported.
• Fixed an issue reading certain old files (those that contained 

duplicate track IDs).
• Fixed a bug writing patch changes and made the reading code 

able to deal with files written by early versions of 10.1 containing 
this bug.

• Fixed a bug that would prevent import of track clippings whose 
resource forks are missing or corrupted.

• Fixed some file modification date comparison bugs that could 
cause the waveform overview and analysis files to be rebuilt 
unnecessarily each time a project is opened.

• Fixed a crash when opening a new document after closing a 
document that had at least one VCA track.

• Fixed a bug where level meters would sometimes spike for no 
reason

• Fixed a bug where chased events would be sent late when 
starting playback.

• Fixed a bug where monophonic aftertouch would not be sent to 
MIDI destinations during playback.

• Fixed a bug where duplicate events could be inserted into the 
track when recording automation.

• Fixed a crash that could occur when changing frame rates.
• Fixed a crash that could occur when canceling track freeze.
• Fixed a crash when trying to add a v-rack track to a temporary 

group in the mixing board.



• Fixed an issue where multiple punch-ins/outs on an audio track 
would only result in one soundbite being inserted.

• Fixed a bug where captured clips wouldn't draw in the Tracks 
Overview or Sequence Editor after a cycle back had occurred.

• Fixed a crash that could occur when drawing soundbite clips being 
captured while memory cycle was enabled.

• Fixed an issue where recorded clip events were getting sorted in 
the wrong direction in the Sequence Editor.

• Fixed an event chasing bug where types could be overridden by a 
clip event that began ahead of the current counter position. 

• Fixed a bug where MIDI notes would not be chased at all unless 
they were inside a clip event.

• Fixed a bug where notes in clips weren't chased properly when 
starting playback.

• Fixed a bug where MIDI scrubbing wouldn't work for tracks that 
only had notes inside of clip events.

• Fixed an issue where recording automation into clips could 
contain multiple return-to-zero points within what should have 
been a smooth curve.

• Fixed a bug where monophonic aftertouch would not play back 
after recording an overdub pass for this event type.

• Fixed a bug where overdub recording MIDI controllers in "latch" 
mode might continue erasing previous track data after manually 
punching out.

• Fixed a bug where auditioning a track data selection would play 
data from unselected clip events in other tracks if they intersected 
the selection time range.

• Fixed an assertion failure when chasing notes in MIDI clip events.
• Fixed a crash that could occur when undoing "paste clip" in the 

clips window after it had been queued to play.
• Fixed an issue where you could not begin recording on an audio 

track after pressing transport-record unless at least one audio 
track was already record enabled before you started the transport 
rolling.

• Fixed a bug where clips overriding automation for a parameter in a 
particular effect instance would also override automation targeting 
the same parameter in different instances of the same effect in the 
track.

• Fixed a bug where a track's "playing clip" in the clips window 
might not actually play.

• Fixed a crash that could occur when playing clips.
• Fixed a bug that could prevent a soundbite inside of a clip from 

playing if it had a fade applied.
• Fixed a graphical bug where waveform artifacts would be left 

behind by the drag-info bubble if it were superimposed over a 
volume automation lane when dragging a soundbite.

• Fixed a crash that could occur when undoing, then redoing, the 



Add VCA Track and Group command.
• Fixed a bug in the Clips Window's handling of "Toggle Clip Editor" 

where it would not close the editor if it was already showing.
• Fixed one more place where disengaging transport record could 

be ignored by the CC-overdub recording system.
• Fixed bug where the wiper would stop moving when mouse was 

not moving.
• Fixed a bug where seeking backward one frame at a time would 

not reliably update the displayed video frame in the movie window.

Enhancements introduced in version 10.01

Version 10.01 introduces the following improvements: 

• Added a preference to completely disable tracks overview wiper 
snapping (Preferences > Editing > Tracks Overview).

• Beat snapping honors the command key to toggle the snap state 
as you drag.

• Cancel run command by hitting the (shift-space) key again.  This 
preserves the search text for next time.

• Applying a track layout preset hides tracks that did not exist at the 
time the preset was created.

• If saving an old Digital Performer document will upgrade it to a 
newer file format, the user will be reminded of this and given a 
chance to use "Save As..." if backward compatibility is required.

• Added an option to allow DP to display audio meters post-pan 
(Play and Record -> Audio Options -> Audio metering is post-pan).

• The maximum bus count is again 1024.
• Welcome window fixes: The news column now opens. Fixed a 

display glitch in the news show/hide button. Fixed a problem with 
the drop shadows associated with each individual news item. 
When you're not on the network, there is no 'Video Tutorials’ 
button.

• The consolidated window’s sidebar panel selection menu is now 
alphabetical within the logical subgroups.

• Reduced audio glitching when reordering tracks. Now a glitch will 
only occur if master track priorities need to be resolved.

• Added string to value conversion to VST2 and VST3 plug-in 
formats.

• Removed the requirement that an AU plug-in must be able to do 
string to value conversion in order to use value to string 
conversion for event value display.  The behavior when viewing 
and editing effect automation in DP is now as follows: 1) If value to 
string conversion is available, it will be used to display event 
values. 2) If string to value conversion is available, events will be 
editable by typing in new values but if string to value conversion is 
not available, events will not be editable by typing new values.



• Fixed a bug where a VST3's processor state could be restored to 
bogus values.

• Fixed an issue with all VST2/3 and AU plug-in formats, where 
examination could get blocked if the plug-in being examined 
output too much diagnostic text (this fixes examination of GForce 
M-Tron and possibly others).

• Improved the way we send automation to VST3 plug-ins.
• Fixed redraw problems in the "Apply Plug-in" window (macOS 

10.11 only).
• Fixed an issue where VCA masters would not control tracks with 

surround outputs.
• Fixed an issue where muted tracks controlled by VCAs could be 

distorted during playback.
• Fixed beat detection algorithm so it handles very small audio files 

(less than 0.1 seconds in length), this was crashing DP.
• Improved Clips window loading time when used with large 

numbers of tracks.
• Fixed a bug where the Clips window would appear to allow clip 

management for temporary take tracks.
• Fixed a crash when dragging an item over the Clips window when 

no tracks are displayed.
• Fixed a crash that could occur when dragging the scroll bar in the 

Clips window track selector if the Clips window was created 
outside of the consolidated window.

• Fixed a graphical glitch that could occur when scrolling 
horizontally in the Clips window.

• Fixed a bug where revealing the track selector in the Clips window 
would make right-most edge of the window unreachable if the 
track selector was set to open inside of its edit window.

• Fixed a bug where the Clips window track grid would be the wrong 
width after popping it into the Consolidated Window while the track 
selector was showing.

• Fixed a bug where MIDI bindings bound to clips in the Clips 
window wouldn't work if one or more v-racks preceded the 
playchunk in the chunk list.

• Fixed a crash that could occur when closing a document 
containing more than one sequence with MIDI event bindings for 
its clips.

• Fixed a bug where soundbites within clips would not play for the 
correct duration if a tempo change occurred while the clips were 
looping.

• Fixed a bug where a clip created by copy and paste would have 
its loop re-enabled if the source clip's loop was disabled.

• Fixed a memory leak that could occur when undoing edits in the 
clip editor.

• Fixed a bug where copying and pasting clips in the Clips window 
would create unnamed undo entries in addition to "Paste Clip.”



• Fixed a bug that made double-clicking unreliable in the Content 
Browser.

• Fixed unpredictable behavior when using the Content Browser's 
back and forward buttons.

• Fixed an issue where the fade resolution system was not allowing 
asymmetrical cross-fades.

• If you delete the end from a soundbite with a fade, the fade is 
preserved. This behavior more closely matches DP 9.

• Fixed bugs that could result in fades not being created when the 
soundbite is off-screen.

• Fixed a crash bug that could occur when performing an Insert 
Measures where the split/insert point intersected one or more 
sound bites.

• Fixed a few issues with Split Notes, including a crash that would 
occur when trying to send the selected notes to a specific track.

• Fixed a crash that could occur when triggering a window set 
created in DP 9 or prior that contained a region op window.

• Fixed an intermittent crash when opening the continuous data 
region op windows.

• Fixed a crash in SndBitePane.
• Fixed a Windows-only bug where the QuickScribe font would be 

used to render patch names in the patch list menus.
• Fixed a crash when choosing a groove in the insert effect version 

of Groove Quantize.
• Fixed a potential crash when editing track options in the 

QuickScribe window.
• Fixed a graphical glitch with long Sequence Editor folder names.
• Fixed a cosmetic anomaly in the Markers window.
• Made the colored square in the track selector fit 10.2 and other 

surround sound labels.
• Added a conductor icon to the track selector in the 'Nine' theme.
• Made the insert automation box in the Sequence Editor line up.
• Fixed a graphics glitch in ‘None More Black’ theme.
• Made the track inspector button draw correctly meaning that the 

color stayed fill when the center column lost focus.
• Fixed a bug where importing a clipping file would fail to reconnect 

track inputs to the appropriate input bundles if the input bundle 
was a hardware input, rather than a bus or virtual instrument.

• Updated the Windows primary plug-in format alert text.
• Allow the track (context) name to be set into AU format plug-ins for 

all manufacturers.
• Notation editor zoom bug. DP would crash if the notation editor 

was open in the background and you zoomed the MIDI editor.
• Fixed layout issues in Final Cut Pro Import dialog.
• Fixed crash when exporting to AAF or OMF with "copy all audio 

files" selected.
• Fixed bug were the wiper would stop moving when mouse was not 



moving.
• Fixed a bug where seeking backward one frame at a time would 

not reliably update the displayed video frame in the movie window.
• Fixed the CC MIDI event colors (and names) in the document 

templates.
• Fixed the default numbers and strings for CC data preference.
• Fixed a bug affecting macOS Catalina where open and save 

dialogs would not forward mouse clicks and other UI events to the 
custom accessory views embedded in the dialog (for selecting file 
formats, etc).

• Fixed an invalid memory access in the save dialog (Mac only).
• Fixed a crash that could occur when opening older documents 

that had loop lanes showing in the Sequence Editor.
• Fixed a bug where garbage data could be saved into a file if the 

project had loop events in them from earlier versions of DP. These 
projects could then crash DP when reopened later, so we added a 
workaround to open these projects successfully.

• Fixed a potential crash when closing windows.
• Fixed a bug where "Mute Toggle Selection" would not work on 

soundbites.
• Fixed a bug where the option to "interpolate automation events at 

edit boundaries" in the Event Chasing window would be invisible 
in some themes.

• Improved the edit boundary automation chasing feature's ability to 
avoid inserting unnecessary "anchor" events.

• Fixed a bug in the edit-boundary automation chasing in which only 
one effect parameter's automation would be preserved around the 
edit boundaries if the edit involved automation for the the same 
parameter on multiple instances of that effect.

• Fixed a crash when using Groove Quantize on an audio track 
selection.

• Fixed a bug where too many undo entries could be created when 
using Groove Quantize.

• Potential fix for intermittently unresponsive video playback.
• Fixed a bug where slowly dragging a marquee selection in the clip 

editor piano roll with smart selections enabled would sometimes 
not redraw notes when their selected-ness changed.

• Improved responsiveness of dragging a marquee selection in 
piano roll views with lots of notes while smart selections are 
enabled.

• Fixed a crash that could occur when dragging a chunk to the Song 
window.

• Fixed templates to have a default movie start time of 1:00:00:00.

New features introduced in version 10.0



Version 10.0 introduces the following new features. For further 
information about these features, go to Digital Performer's Help menu > 
New Features in Digital Performer 10. 

Clips window — The Clips window is a dynamic, interactive 
environment for triggering audio and MIDI clips during live performance. 
You can prepare any number of MIDI and audio clips and then 
individually trigger them during playback. The Clip Editor lets you view, 
edit and create clips.

Audio stretch edit layer — Both the Sequence Editor and Waveform 
Editor have a new Stretch edit layer that allows you to grab audio beats 
and stretch them earlier or later in time to modify their timing.

Beat Detection Engine 2.0 — DP’s Beat Detection Engine has been re-
engineered to make beat and tempo operations on rhythmic audio easier 
than ever.

Enhanced Waveform Editor — The Waveform Editor has been greatly 
enhanced and streamlined.

Content Browser — The new Content Browser gives you immediate 
access to assets that you can quickly drag and drop into your Digital 
Performer project, such as audio files, loops, plug-ins, virtual instruments 
and clippings.

VCA tracks — Modeled after classic analog consoles, VCA tracks allow 
you to control the relative level of any number of tracks from a single 
fader. With complete flexibility, you can control VCA tracks with other 
VCA tracks, creating nested sub-groups. Mix automation is maintained 
throughout, even for sub-grouped faders.

VST3 support — VST3 plug-ins and virtual instruments are now 
supported in Digital Performer.

MOTU Instruments soundbank — DP10 includes a 5.5 GB library of 
multi-sample instruments, synths, loops and phrases, including over 300 
different instruments, 1100 instrument presets and 500 loops. Categories 
include acoustic and electronic drum kits, pianos, guitars and basses, 
along with church organs, electric organs, strings, brass, woodwinds, 
synths, ethnic instruments, choirs, voices, percussion, sound effects and 
more. For more information, go to the Help menu in Digital Performer 
and choose Digital Performer Plug-ins Guide.

User interface scaling — You can now scale Digital Performer’s entire 
user interface, including all windows and text, larger and smaller. This is 
especially useful on today’s high-resolution Retina displays.



Run command window — Type shift-spacebar (or choose Setup menu 
> Run Command…) to open the Run Command window, which provides 
a command-line style interface for quick access to commands. 
Essentially, it’s like Spotlight (in macOS) or Windows Search (in the Start 
menu) for commands. Several preferences are also provided.

Enhanced Quantize — The Quantize command now offers the option to 
move MIDI controller data along with its associated MIDI note when it is 
being quantized. This allows you to preserve the timing between the note 
and any controller data affecting it. A separate option provides the same 
functionality for plug-in automation data for soundbites when they are 
being quantized, or even beats within soundbites.

Enhanced Groove Quantize — The Groove Quantize command now 
offers the same option as above for moving MIDI controller data and 
audio automation along with its associated MIDI notes and audio beats to 
help preserve the timing between them.

Alternate Tool — The new Alternate Tool can be chosen in the Control 
Panel and invoked using the 'x' key (or any customized keystroke), 
allowing you to switch quickly between the main tool and alternate tool 
without repeated trips to the Tool palette.

Absolute vs. relative grid snapping — Now, by default, Snap to Grid 
(in the Snap Information window) snaps data to the absolute time line 
grid. There is a new Snap Relative check box option that snaps data 
relative to its original position with respect to the absolute grid.

Auto Snap to Grid — Snap to Grid now has two modes: Fixed and Auto. 
In Fixed mode, you can specify the grid size, as usual. In Auto mode, DP 
chooses an appropriate grid size based on the zoom level of the edit 
window you are working in.

Incremental transport cueing — In Digital Performer’s main transport 
controls, the cueing buttons (fast/slow forward and rewind) can now be 
configured to cue in fixed increments in any time format. For example, 
you can program the slow forward/rewind buttons to cue by one measure 
and the fast forward/rewind buttons to cue by four measures. You can 
also cue by any number of beats, ticks, frames and seconds.

Region command presets — You can now create and save presets for 
Region menu commands such as Quantize, Transpose, Change 
Duration and Split Notes.

Event list “quick” filter — The event list now displays a “quick filter” 
section at the top of the list to easily hide types of data temporarily.



Effects inserts in the Sequence Editor — The Sequence Editor now 
displays effects inserts in an expandable panel to the right of the track 
settings panel.

Enhanced track reordering — You can now select multiple tracks in the 
Track list (even a non-contiguous selection of tracks) and then drag them 
together as a group up or down in the Track list to move them all to the 
destination location in one step. 

Overdub recording of MIDI CC data — When overdub recording MIDI 
continuous controller data, existing data in the track is now replaced by 
new data according to the track’s automation mode setting (Touch, Latch, 
etc.)

Enhanced track data clippings — Clippings that consist of track data 
can be dragged and dropped into the Track List, Track Overview and 
Sequence Editor. When doing so, you can now simultaneously create 
new tracks and drop at a specific location on the time line, in one 
operation. In addition, any busing between multiple tracks within the 
clipping is preserved.

Consolidated zoom menus — The zoom menus in the Sequence 
Editor, Drum Editor, MIDI Editor and Waveform Editor have been 
consolidated into a single menu item in the main menu bar (View > 
Zoom).

Enhanced soundbite dragging — When dragging soundbites in the 
Sequence Editor to move them, Digital Performer now displays their 
complete waveform while dragging to make it easier to align the 
waveform with surrounding tracks. In addition, a new information tab 
appears while dragging to convey metrics such as the new position, 
offset, start time and end time.

New MIDI note display preferences  — There are several new 
preferences for the way MIDI notes can be displayed in the Graphic 
Editor note grid. For example, you can display the MIDI note number and 
on-velocity bar inside the note.

Canceling while dragging — You can now cancel in the middle of a 
dragging operation by pressing the escape key.

Cell focus — When a cell in the Consolidated Window becomes the 
focused cell (by clicking its title bar), it now displays a color-configurable 
border around the outside edges of the cell, to more clearly indicate that 
the cell has the focus.



Bite Gain fader — When audio tracks are resized vertically in the 
Sequence Editor, and expanded far enough, each soundbite displays its 
Bite Gain setting and fader in the bottom left corner.

Playback wiper snaps to grid — When you drag the playback wiper, it 
now respects grid snapping, if enabled.  To disable wiper snapping at any 
time, simply hold the command key (control key on Windows).

*****

We hope you enjoy using Digital Performer 10.1. We welcome your 
comments and suggestions.

Sincerely, 

The Digital Performer Development Team
www.motu.com/techsupport
www.motu.com/suggestions
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